
Excel 2003 Instructions

Using Excel for Business Analysis: A Guide to Financial Modelling Fundamentals
contains extensive instructions for using Excel 2010 and Excel for Mac 2011. There

are a few instances where the technical instructions differ from Excel 2010 or 2007 to
the older “classic” Excel 2003 and so we have created this document just in case you
are still using the older version.

It contains instructions on the following topics.

Topic Book chapter Page number in book
Page number in
this document

Methods and Tools of
Assumptions Documentation

Chapter 3 Page 42 Page 2

Dealing with Links and the
Potential Errors They Can
Cause

Chapter 4 Page 62 Page 2

Circular References Chapter 4 Page 67 Page 3
Named Ranges Chapter 5 Page 89 Page 3
Functions for Financial

Modelling
Chapter 6 Page 93 Page 4

Basic Formatting Chapter 7 Page 133 Page 4
Cell Styles Chapter 7 See “Additional

Material” document
in Supplementary
Material

Page 5

Conditional Formatting Chapter 7 Page 139 Page 5
Bulletproofing your Model Chapter 7 Page 147 Page 6
Data Validations Chapter 7 Page 153 Page 7
Form Controls Chapter 7 Page 157 Page 7
Hiding and Grouping Chapter 8 Page 173 Page 8
Goal Seeking Chapter 8 Page 184 Page 8
Pivot Tables Chapter 8 Page 186 Page 8
Macros Chapter 8 Page 190 Page 10
Formula Auditing Chapter 10 Page 236 Page 11
Scenario Manager Chapter 11 Page 254 Page 12
Using Data Tables for

Sensitivity Analysis
Chapter 11 Page 256 Page 13

Advanced Conditional Formatting Chapter 11 Page 261 Page 13
Charting Chapter 12 Page 291 Page 14
Charting with Two Different

Axes and Chart Types
Chapter 12 Page 300 Page 14

Bubble Charts Chapter 12 Page 302 Page 15
Creating a Basic Waterfall Chart

(with Only Positive Values)
Chapter 12 Page 308 Page 15
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CHAPTER 3

Methods and Tools of Assumptions Documentation

Assumptions documentation is an important part of any financial model. There are
several tools which can be used for documenting assumptions, one of which is inserting
in-cell, or “red triangle” comments.

In-Cell Comments

How to Insert a Comment (Page 43) Select Insert from the menu bar and select Comment
from the drop-down menu. Enter the comment in the text box, and click outside the
comment box.

How to View All Comments in the Worksheet (Page 44) Go to the View option on the menu
bar and select Comments from the drop-down menu. This will show every comment in
the sheet. To hide them, select the Comments option from the drop-down menu again.

Data Validation Input Messages

How to Insert an Input Message (Page 44) Select Data from the menu bar and select Val-
idation from the drop-downmenu. Select the second tab entitled InputMessage and type
the message you wish to see. This message will appear only when the cell is selected.

Hyperlinks

How to Insert a Hyperlink (Page 46) Select Insert on the menu bar, and select Hyperlink
from the drop-down menu. On the left-hand side, select Place in This Document. Select
the sheet and cell reference or named range of the hyperlink source. You can change the
Text to Display at the top to display something like Go to Staff Salaries instead of Sal-
aries!A45, for example. Similarly, you can insert a hyperlink to another file in your source
referencing.

How to Insert a Hyperlink to Another File (Page 47) Select Insert on themenu bar, and select
Hyperlink from thedrop-downmenu.Click on theBrowse for file iconwhich is located at
the top right-hand corner. Select the file that youwant to insert. It can be any file type.Hit
OK, and this will create your hyperlink. You can also create a hyperlink to another file or
webpage that does not show the full web or file address of the file. Follow the instructions
above, but change the Text to Display field at the top of the Edit Hyperlink dialog box
such that it shows your desired text rather than the full file path or web address.

CHAPTER 4

Dealing with Links and the Potential Errors They can Cause

If you have linked two files together, you should not start moving either of the files
around (into other drives or directories). If you do, Excel will not be able to find the file
that has been moved, and will be unable to maintain the link. If you need to update or
change the links between files, you can do so by editing the links.
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How to Edit Links (Page 62)
1. Select Edit from the menu bar and select Links from the drop-down menu.
2. Use the Change Source button to tell your model the new location of the file it has

been linked to. You can also Break Link here to remove all external links in the
entire model.

Circular References

Circular references can be rather tricky to hunt down within a model. If you aren’t sure
which tab the circular reference is on, you need to find it by going to each tab to see if it
shows on the status bar. Alternatively, you can use the auditing tool to locate the
circular reference.

Locating a Circular Reference with the Auditing Tool (Page 68) To display the Circular
Reference toolbar, as shown in Figure 1, select View from the menu bar, select Tool-
bars from the drop-down menu and then click on Customize. This will bring up the
dialog box. Select Circular Reference from the Toolbars tab. Alternatively, the toolbar
will show up automatically as soon as a circular reference has been created. Click on
the reference to go to the circular reference.

Enabling Iterative Calculations

If you want to allow circular references in your model, you need to change the options
within Excel in order to enable iterative calculations.

How to Enable Iterative Calculations (Page 70) Select Tools from the menu Bar, Select
Options from the drop-down menu and then select the Calculation tab. Tick the
Iteration box.

CHAPTER 5

Named Ranges

Named ranges can be useful, but it’s not good practice to have too many. They can be
confusing—especially if you have not used a consistent naming methodology. It’s also
quite easy to accidentally name the same cell twice. So in order to keep names neat and
tidy, you might need to edit or delete them.

FIGURE 1 Circular Reference Auditing Tool in the Ribbon in Excel 2003
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Also, if you have added more data to a spreadsheet, and a range name no longer
expresses the correct range of cells, you can redefine the named range.

How to Edit or Delete a Named Range (Page 92) Select Insert from the menu bar, select
Name from the drop-down menu and select Define.

The only difference between Excel 2007/10 and 2003 in this instance is that you
can now add comments to named ranges in 2007/10. Also, it is now called a Name
Manager in 2007/10, but otherwise works in exactly the same way as it did in 2003 and
still does in Excel 2011 for Mac.

CHAPTER 6

Functions for Financial Modelling

This chapter covers several of the new functions which are not available in the standard
Excel 2003.

n COUNTIFS and SUMIFS
n AVERAGEIF and AVERAGEIFS
n EOMONTH
n XNPV and XIRR
n EFFECT

Some of these functions are also available in 2003 through the Analysis ToolPak
Add-Ins, but bear in mind that if a 2003 user (without the ToolPak installed) opens the
file it will show a #N/A error. It’s generally best to steer clear of new functions such as
EOMONTH unless you know for sure that all users likely to open up the model are
using 2007 or above.

CHAPTER 7

Basic Formatting (Page 133)

In 2003, the Formatting toolbar, shown in Figure 2, is usually displayed at the top. If
not, you can access it by selecting View—Toolbars—Formatting.

For detailed cell formatting options, select Format from the menu bar and then
select Cells, or right-hand click on the cells, and select Format Cells. The majority of
formats, such as alignment and Merge and Center described in the book can be
accessed in Excel 2003 either through the formatting toolbar or through Format Cells.

FIGURE 2 Formatting Toolbar in Excel 2003
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Excel 2003 has the most commonly used formats pre-set on the Format Toolbar;
namely currency, percent, thousands separator, and decimal places, but dates are not
there. See Figure 3. You’ll need to use the FormatCellsDialog Box to format cells to dates.

Cell Styles

Styles are available in Excel 2003 but it does not have these pre-defined styles, so whilst
you can still create your own, very similar styles, it’s much more difficult and cum-
bersome to build. You can still create and edit styles by selecting Format from the menu
bar and then selecting Styles, but the quick access selection templates showing the
preview with how the formats look, (as shown in the supplementary document
“Additional Material”) is only available in Excel 2007 or 2010.

Conditional Formatting (Page 139) There are many more options available in Excel 2007/
10, so by comparison Excel 2003 is rather limited. All of the basic functionality of
conditional formatting is available in 2003 but one of the most restrictive limitations is
that only three conditions can be applied to any cell.

To Apply Conditional Formatting

1. Select the desired cell(s) in the spreadsheet. Let’s say, for example, you wanted to
highlight in red font any cell value between 1 and 10.

2. Select Conditional Formatting from under the Format menu bar. The Conditional
Formatting dialog box will appear. See Figure 4.

3. Leave the settings as Cell Value Is and “between” as shown in Figure 4 above.
Type in 1 and 10, in the fields to the right, and select Format to define the desired
Font, Border, or Patterns/Shading.

4. Click the Add button if you wish to add more conditions, but only three, as
conditional formatting in 2003 is limited to only three conditions!

FIGURE 3 Formatting Toolbar in Excel 2003

FIGURE 4 Conditional Formatting in Excel 2003
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To Remove Conditional Formatting

Select dialog box as shown above, press the Delete button, and delete each rule
individually.

Bulletproofing your Model

If your model is publicly available, or if you have a lot of users entering data into it
(especially if their Excel skills are questionable), it’s a good idea to spend some time
protecting it and making sure that all your hard work is not inadvertently corrupted!

Protect the Structure

If you have a sheet containing sensitive data, you can hide the entire sheet, and then
protect the workbook so that the sheet cannot be viewed. This is particularly handy if,
for example, you have salary data on a sheet in a budget model and don’t want all users
to have access to the salaries.

How to Protect Hidden Sheets (Page 149)
1. Put all sensitive information on one sheet.
2. Select Format from the menu bar, select Sheet and then select Hide.
3. Now protect the structure of the workbook so that users cannot unhide sheets by

selecting Tools from the menu bar, Select Protection, and then select Protect
Workbook.

4. If you enter a password, users will need a password in order to view the sheet(s)
you have hidden.

Protect the Worksheet

This is the most commonly used form of protection. If you have created a spreadsheet
that you do not want to be altered by the other people who might view it, you can
protect the sheet. You can either protect the whole sheet, or just certain key cells in the
sheet (probably those containing the formulas) so that new data can still be entered
onto the sheet.

How to Protect a Worksheet (Page 149)
1. Select the sheet you wish to protect.
2. Select Tools from the menu bar, select Protection from the drop-down menu and

then select Protect Sheet.
3. This will bring up the Protect Sheet dialog box, in which you can enter a password

to prevent users from unprotecting the sheet. You do not have to use a password;
you can just leave the Password box empty, and this may be enough of a deterrent
to prevent users from modifying your model.

4. Enter a password (if necessary) and click OK.
5. If you have entered a password, you will be asked to confirm the password.
6. Type in the password again.
7. The whole sheet is now protected. Users will not be able to change the contents of

any cell. If you need to change cell contents you will need to unprotect the sheet.
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Note that if you want the user to be able to edit certain cells, simply unlock them
by changing the formatting to Unlocked before protecting the sheet.

How to Unprotect a Worksheet (Page 150)
1. Select the tab name of sheet you wish to unprotect.
2. Select Tools from the menu bar, select Protection from the drop-down menu and

then select Unprotect Sheet.
3. If no password was originally used to protect the sheet, then the sheet will auto-

matically be unprotected at this point.
4. If a password has been used, the Unprotect Sheet dialog box will appear. Enter the

password and click on OK.

Customising the Display Settings (Page 151) The customisation options described in this
section can be found by selecting Tools, then Options, and on the View tab, unticking
the relevant option.

Data Validations

Data validations are useful for restricting what users can enter into certain cells.

How to Apply Data Validations (Page 154) Data validations can be accessed in Excel 2003
by selecting Data from the toolbar and Validation from the drop-down menu. Once
the dialog box appears, you can follow the instructions described in the book, as the
functionality has not changed between versions.

Form Controls

Accessing Form Controls (Page 158) If you are using Excel 2003, there is a Forms toolbar
that can be placed on the menu by selecting View from the drop-down menu, then
selecting Toolbars, and then Forms. See Figure 5.

FIGURE 5 Forms Toolbar in Excel 2003
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All form controls work very similarly in different versions of Excel, except that in
Excel 2003 they are accessed via the Forms Toolbar instead of the Developer tab
in the Ribbon. Properties can also be accessed via the Forms Toolbar instead of the
Ribbon. Combo boxes, Option buttons, and spin buttons can be created in a very
similar way, and the instructions for building these can be followed in the book on
pages 159�171.

CHAPTER 8

Hiding and Grouping

To Hide or Unhide a Sheet (Page 175) Select the sheet(s) you want to hide or unhide. Hold
down the Control key if you want to hide several sheets at a time.

Select Format from the menu bar, then select Sheet, then Hide/Unhide

To Protect Hidden Sections of a Model (Page 178) If you have hidden rows or columns,
apply the protection to the worksheet itself by selecting Tools from the menu bar,
selecting Protection from the drop-down menu, then Protect Sheet.

If you have hidden a sheet, apply protection to the structure of the workbook by
selecting Tools from the menu bar, then Protection, and then Protect Workbook.

Grouping (Page 178) Using the grouping is much better practice when hiding sections of
a sheet because it is more difficult to overlook the hidden cells. To use the grouping
tool, highlight the columns or rows that you want to hide and then go to Data—Group
and Outline—Group/Ungroup.

Goal Seeking

Goal seek is a very handy and commonly-used tool in financial modelling and analy-
sis. Goal seek is used to adjust the value in a specified cell until a formula dependent on
that cell reaches the result you specify.

Using a Goal Seek (Page 184) To use goal seek in Excel 2003, select Tools from the
toolbar, then Goal Seek from the drop-down menu. The dialog box is exactly the same
as the other versions.

Pivot Tables

Useful as they are, pivot tables are not used very widely in financial modelling. This is
because they are static until refreshed, and this does not fit very well with the meth-
odology of most financial models.

Automatic Refresh (Page 187) To change the settings of a pivot table so that it auto-
matically refreshes whenever the file is opened, right-hand click on the pivot table, go
to Pivot Table Options, and under Data Options, click Refresh on open.
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How to Create a Pivot Table (Page 188)
1. Highlight the entire database, ensuring that the headings are at the top of the

range.
2. Select Data from the menu bar and then select Pivot table and Pivot Chart Report.
3. Click through the wizard, selecting the defaults, until you get to Step 3, as shown

in Figure 6.

4. Click on the Layout button as shown above.
5. In the Layout wizard, as shown in Figure 7, drag the field that you want shown in

the rows at the left of the field in the ROW area (i.e. Customer), the fields you
want across the top in the COLUMN area (i.e. Product), and the value you want
added together in the DATA area (i.e. Price).

FIGURE 6 Pivot Table Wizard in Excel 2003

FIGURE 7 Layout View of the Pivot Table Wizard in Excel 2003
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6. If you want to show Area and then Department, drag the Area field above the
Department field in the ROW area to the left. Click on OK, and then you’ll be
asked where to put the new pivot table. Tell it you want a new page.

7. Right-click, and go back into the wizard to edit the pivot table.
8. Although building the pivot table is very different in each version of Excel, you

should end up with very similar results. See Figure 8.

Macros

Setting Macro Security Levels (Page 191)
1. Select Tools from the menu bar, select Options from the drop-down menu, and on

the Security tab, press the Macro Security button.
2. Choose from Low, Medium, or High security. You’ll need to choose either

Medium or Low security in order for your macros to run.
a. High security: You won’t be able to run macros.
b. Medium security: It will prompt you whether you want to run macros or not.
c. Low security: It will allow all macros to run.

To Record a Macro (Page 192) Select Tools from the menu bar, select Macro, and then
Record New Macro.

This will bring up the Record Macro dialog box.

FIGURE 8 Completed Pivot Table in Excel 2003
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To Stop Recording (Page 193) Press the Stop Recording button that has appeared, or
select Tools from the menu bar, select Macro, then select Stop Recording.

To Run the Macro (Page 193) Select Tools from the menu bar, select Macro, and then
Macros.

Creating Macro Buttons

You can assign a macro to almost any object or shape on your Excel worksheet,
including shapes, buttons, and even combo-box drop-downs. The most commonly used
object is a rectangular button. There are two ways of creating these buttons, either as
shapes or traditional form buttons.

How to Create a Shape (Page 195) Select Insert from the menu bar, select Picture from the
drop-down menu. This will bring up the AutoShapes toolbar and you can select a
rectangle from the Basic Shapes.

How to Create a Traditional Form Button (Page 196) The Form button is located on the
toolbar in Excel 2003. To display the Forms toolbar, as shown in Figure 9, select View
from the menu bar, select Toolbars, and then Forms. Select the button from the toolbar.

CHAPTER 10

Formula Auditing

One of the most effective ways to start understanding a financial model (especially one
that you did not build yourself!) is to look at the formulas and identify the precedents
and dependents.

Tracing Precedents (Page 236) To trace precedents in Excel 2003, select Tools from the
menu bar, select Formula Auditing from the drop-down menu, then select Trace Pre-
cedents. See Figure 10. You can always add Formula Auditing to your toolbar, so you
can access it more easily.

FIGURE 9 Forms Toolbar in Excel 2003
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Tracing Dependents (Page 237) Similarly, to trace precedents in Excel 2003, select Tools
from the menu bar, select Formula Auditing from the drop-down menu, then select
Trace Dependents.

Error-Checking Tools (Page 239) The error checking tool can be found in Excel 2003, by
selecting Tools from the menu bar, then Formula Auditing, and then Error Checking. If
you have the Formula Auditing toolbar displayed, you can click on the Error Checking
button directly too.

Viewing All the Formulas (Page 243) If you want to just look at all the formulas and not
the evaluated value, you can use the Show Formulas option in Excel. This can be done
by selecting Tools from the menu bar, then Options, and under the View tab, tick
Formulas. This can also be done using the shortcut CTRL þ ‘ (this little-used key is
normally located to the left of the numbers row at the top, and shares a key with the B
symbol).

Direct Editing (Page 244) By default, Excel allows users to edit the formulas directly in
the cell, so that when you double-click on a cell it allows direct editing. However, Excel
allows users to disable direct editing, thereby protecting the cells to a degree, but still
allowing users to view the formula.

To disable direct editing in Excel 2003, select Tools from the menu bar, select
Options, then select Edit. Deselect the Edit Directly in Cell option.

CHAPTER 11

Scenario Manager

Scenario Manager is an Excel tool in which you can create multiple scenarios. Once it is
set up, the user can select a scenario, and input cells will change automatically.

FIGURE 10 Trace Precedents in Excel 2003
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Accessing the Scenario Manager Dialog Box (Page 254) Select Tools from the toolbar and
then select Scenarios from the drop-down menu. The dialog box works exactly the
same in different versions of Excel.

Using Data Tables for Sensitivity Analysis

Data tables are one of the more advanced and complex financial modelling tools that
can be used for scenarios and sensitivity analysis.

Access the Data Table Dialog Box (Page 256) Select Data from the toolbar, then select
Table. The dialog box works exactly the same in different versions of Excel, so you can
then follow the instructions in the book.

Advanced Conditional Formatting

A data table is a good opportunity to use conditional formatting with a formula.

To Create a Conditional Formatting Rule with a Formula (Page 261)
1. Select the entire data table
2. Select Format from the menu bar, select Conditional Formatting, and choose the

option Formula is.
3. Follow the instructions in Chapter 11 to enter the formula.
4. Use the Add button of the Conditional Formatting dialog box to add the next

formula. See Figure 11.

To Modify Conditional Formatting (Page 263) Select Format from the menu bar, then
Conditional Formatting.

FIGURE 11 Conditional Formatting Dialog Box in Excel 2003
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CHAPTER 12

Charting

Changing the Source Data (Page 291) Right click on the chart area and click Source Data
from the menu that appears. Once the Source Data dialog box is open, select the Series
tab. Series can be added, edited, and deleted from here.

To Save a Chart as a Template (Page 294)
1. Right-hand click on the chart and select Chart Types.
2. Select the second tab, labelled Custom Types.
3. Select User Defined, then Add. See Figure 12.
4. Create a name for your new chart template.

To Insert Data Tables in a Chart (Page 296) Data tables can be added to charts by right-
hand clicking the mouse and selecting Chart Options. On the Data Table tab, tick the
Show data table box.

Charting with Two Different Axes and Chart Types (Page 300)

Highlight the data, select Insert chart from the Chart menu, then Finish to complete the
chart wizard.

To enter the title, right-hand click, go to Chart Options, and enter the title under
Chart Title, under the Title tab.

FIGURE 12 Saving a Chart Template in Excel 2003
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Bubble Charts (Page 302) Select Chart from the Insert menu. When the chart wizard
appears, simply choose Bubble, then click Finish.

To enter the title, right-hand click, go to Chart Options, and enter the title under
Chart Title under the Title tab.

Right click on the bubbles to select them, then right click and choose Format Data
Series. Go to the Data Labels tab, and select Bubble Size. Click OK.

Creating a Basic Waterfall Chart (with Only Positive Values) (Page 308) Select Chart from the
Insert menu. When the chart wizard appears, simply choose Stacked Column, then
click Finish.

Once the chart has been created, you might like to remove the background grid-
lines by clicking on them and deleting. We need to make the bottom series the same
colour as the chart background. If you are using Excel 2003, the background of the
chart is probably grey, not white, so you can change the background colour by right-
hand clicking on the chart, and selecting Format Plot Area.
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